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1 Introduction

Before starting this tutorial, it is important to understand the basic concepts used in
PragmaDevProcess. These concepts derive from the language supported byPragmaDev
Process, i.e., BPMN.
BPMN stands for Business Process Model and Notation. BPMN is a graphical
language defined by the Object Management Group (OMG). Its primary goal is to pro­
vide a notation that is understandable by all business users, from the business analysts
that create the initial drafts of the processes, to the technical developers responsible for
implementing the technology that will perform those processes, and finally, to the busi­
ness people whowillmanage andmonitor those processes. In doing so, BPMNprovides
a simple mean of communicating process information to other business users, process
implementers, customers, and suppliers.
The following are the most important elements of a BPMN diagram in PragmaDev Pro­
cess:

• A Collaboration is a collection of Participants shown as Pools, their interac­
tions shown byMessage Flows, and may include Processeswithin the Pools.

• A Lane is a sub­partition within a Pool that is used to organize and categorize
Activities of a Process within a Pool.

• A Process describes a sequence or flow of Activities in an organization with
the objective of carrying out work. In BPMN a Process is depicted as a graph of
flow elements, which are a set of Activities,Events,Gateways, andSequence
Flows.
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2 The model

Themodel we have chosen is simple enough to be written from scratch but rich enough
to pinpoint the basics of BPMN. It is a pizza deliverymodel composed of a pizza Vendor
and aCustomer. Vendor’s activities are categorized in activities carried out by theClerk,
Chef, and Delivery Boy. Upon receiving an order from the Customer, the Clerk will
forward such order to the Chef. The Chef will then bake the pizza and hand it over to
the Delivery Boy. At last the pizza will be delivered to the Customer.
The BPMN model of the pizza delivery used in this tutorial is found in $PRAGMADEV_-
PROCESS_HOME/examples/Pizza.

2.1 Organization

Let’s get our hands on the tool! Start PragmaDev Process. The window that appears is
called the Project Manager:

Save the project via the button in the toolbar:
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Name the project Pizza:

Create and add a new BPMN file to the project via the button in the toolbar:

Name it Pizza:

2.2 Pools and lanes

Double click Pizza.bpmn in the Project Manager to open it in the BPMN Editor:
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To change the name of the current diagram use the button:

Name it main and hit "OK":

Notice the change in the diagram browser:
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Create a horizontal pool via the tool button:

and name it Customer:

Resize the pool using the points to create space for other elements:
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Create another pool named Vendor and resize it:

Create three horizontal lanes inside the Vendor using the tool button:

Name them Clerk, Chef, Delivery Boy, and resize them as shown:
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2.3 Processes

Use the tool buttons to draw the Customer process as shown:

Symbols can either be created with the tools in the toolbar, or via keyboard shortcuts.
The insertion shortcuts are all introduced by "Control + Space" (or "Command + Con­
trol + Space" on macOS), followed by a letter giving the type of symbol to create. For
example, to create a start event, press "Control + Space" followed by "s"; with "t", it
creates a task, with "i" an intermediate event, with "g" a gateway, and so on. To see the
available letters, you can press "Control + Space", then "?".
Symbols created with the keyboard shortcuts will always be plain ones. Their type can
however be changed afterwards by opening the symbol properties:
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then changing its type in the right­hand side panel in the editor window:

Links can also be created via a "Control + Space" sequence: with "Shift + s", it creates
a sequence flow and with "Shift + m" a message flow. Sequence flows can also be cre­
ated automatically from the previously selected symbol to the newly inserted one if the
option "Automatically create sequence flows" is checked in the "Edit" menu.
Sequence (or message) flows are drawn as a straight line by default. To create non­
linear paths, right click a flow to "Add waypoint", andmove the waypoint to the desired
position:
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Non­linear paths can be created also by holding "Shift" and clicking to place waypoints
while drawing the path from the source to the target symbol.
The Customer process says the following:

• The Customer is Hungry for pizza.
• He/She decides to Order a pizza.
• The Customer will wait until his/her pizza is delivered (Pizza received).
• If the pizza is not delivered within 30 minutes, the Customer will check what’s
going on with his/her pizza (Ask for pizza).

• Upon receiving the pizza, the Customer will Pay the pizza, Get receipt, and
finally Eat the pizza to be Satisfied.

Draw the Vendor process as shown:

The Vendor process says the following:
• Upon receiving an order from the Customer, the Clerk will enter a loop waiting
for complaints (Where is my pizza?), and in case of a complaint the Clerk will
try to Calm customer.

• The Clerk will also forward the received order to the Chef to Make the pizza.
• When ready, the Chef will hand over the pizza to the Delivery Boy to Deliver
the pizza.

Notes:
• Deliver the pizza is a process call activity.
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• The process ends with an intermediate event. This error is intentional, and will
be corrected later in the tutorial.

To complete the Customer­Vendor collaboration draw the following message flows:

Let’s define now the call­activity Deliver the pizza. Add a new diagram via the
button at the bottom of the diagram browser:

Name it delivery and hit "OK":

The new empty diagram will be selected. Draw the following:
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When creating the message flows be sure to draw starting from / ending to either the
border or header of the pool Customer.
Save the changes and go to the maindiagram. Right click the call­activity and then "Link
to process...":

Select the single available option (except none) in the dialog and hit "OK":
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Right click the call­activity and then "Open definition":

This should display the delivery diagram in the editor.
The model of the pizza delivery is now complete. Save everything before closing the
editor.
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3 Execution

Now we will execute the model using PragmaDev Process BPMN Executor. There are
two kinds of execution:

• Interactive: allows the user to have full control over the execution. The user in­
teracts with the model at every step of its execution.

• Automatic: enables model execution without user input. The execution is guided
by MSC traces.

3.1 Semantic check

The model can be executed only if it conforms to BPMN 2.0 semantics. To make sure
this is true, select Pizza.bpmn in the project manager and click the "Check syntax &
semantics" button:

A window will pop­up showing the result of the semantic check on the model:
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Double­clicking either of the listed errors will open the model in the editor and the
concerned element will be selected:

Replace the intermediate event with a terminate end event to correct the errors:
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Re­running a semantic check on the model should not list any errors:

3.2 Interactive execution

With Pizza.bpmn opened in the editor (double­click on it in the project manager), click
the "Record" button:
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This will allow us to record the execution in theMSC Tracer:

We can now start the execution via the "Start" button:

Start events and executable flows will be marked in blue:
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Please note that generally speaking only sequence flows, some message flows, or call­
activities can be clicked. No other symbol can be clicked even though they appear in
blue. In our example there is a single sequence flow that can be executed. Clicking on
it will advance execution, i.e., make the Customer order a pizza:
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The next (and only) step will be for the Customer to send the pizza order to the Clerk;
to continue click the sequence flow:

The pizza order will start the Vendor process. Clicking the sequence flow will result
in:

By entering the event gateway, the Customer will wait for its pizza to be delivered (i.e.,
the Pizza received event) and start a 30 minutes timer. If the timer fires before the
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pizza is delivered, the Customerwill ask the Clerk for the pizza. On the other hand, the
parallel gateway in the Vendor process will allow the Clerk to listen to any Customer
queries, while the Chef starts baking the pizza.
While execution advances in the editor, all steps are also being recorded in the MSC
Tracer:

Let’s make the timer fire, the Clerk listen for Customer queries, and the Chef start
baking the pizza by clicking all three sequence flows:
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Notice that the Pizza received event is no longer active because the 30 minutes event
was triggered. In this situation the Customer is asking the Clerk for the pizza, while
the pizza is being prepared by the Chef. If query for pizza is sent:
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By clicking the sequence flow, the Clerk will Calm customer while the later will be
waiting for a feedback (i.e., the Pizza on its way event):
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Make the Clerk respond to the Customer’s query by clicking the sequence flow which
will automatically send the patiencemessage:

Continue by clicking the looping sequence flow in the Customer process:
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The Customer will get back to waiting for the pizza or for another 30 minutes to pass
before querying the Clerk again. We will not let the Customer wait any longer, so let’s
make sure the pizza is ready by clicking the sequence flow outgoing Make the pizza:
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Now it’s time to Deliver the pizza. This is a BPMN call­activity which calls the pro­
cess defined in the delivery diagram. We can either step­over (right­click) or step­in
(left­click) the call­activity. Stepping over the call­activity will not execute the called
process, but will consider the activity as being a simple BPMN task. In this case the ex­
ecution will block because the activity will wait for the receiptmessage before sending
the pizzamessage. Stepping in the call­activity will show the delivery diagram in the
editor and start the called process:
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We can Give the pizza to the Customer by clicking the sequence flow:

and then the following sequence flowwhich will automatically send the pizzamessage:
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If we switch to the main diagram in the editor we can see that the Customer has indeed
received the pizza and can proceed with the payment:

Click the next two sequence flows to give the money to the Delivery Boy:
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Continue by clicking all possible flows in both diagrams until there is nothing left to do,
i.e., execution is finished:
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To generate model coverage click the "Generate coverage" button:

Coverage information will be shown as follows:
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Coverage information helps to identify complementary scenarios in order to verify the
process. Please note several coverage information can be merged to make sure a set of
scenarios do actually cover all symbols.
Close the coverage window and stop the execution via the "Stop" button:

Save the recording via the "Save trace" button in theMSC Tracer:

Give it a name (e.g., pizza_ok), and it will be added automatically to the project:
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3.3 Automatic execution

3.3.1 Single-trace execution

It is possible to replay a scenario. With Pizza.bpmn opened in the editor (double­click
on it in the project manager), click the "Replay" button:

All recordings (MSC traces) found in the project will be listed; select pizza_ok and click
the "OK" button:

The pizza_ok will be opened in the MSC editor:
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while the execution will start automatically in the BPMN editor:
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Click the "Step" button in the MSC editor:

The first sequence flow will be selected in the MSC editor:
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and executed in the BPMN editor:
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Try the "Step" button a couple of times and observe both (MSC trace and BPMNmodel)
as execution advances in steps. Now click the "Run" button:

Execution will continue until no more steps are left:
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Check also the BPMN editor:
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Use the "Stop" button to terminate execution.
With the pizza_ok opened in the editor, find the 30 minutes timer and change it to 10
minutes:
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Save the modified MSC trace as pizza_ko via the menu "Diagram / Save as..."; it will
be added to the project:
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WithPizza.bpmn still opened in the editor, click the "Replay" button, and select pizza_-
ko for execution:

In the MSC editor click the "Run" button. Execution will stop at the timer symbol com­
plaining about text mismatch:
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3.3.2 Multi-trace execution

The tool can replay automatically several scenarios in a row to make sure they are still
valid. Stop execution (if still running), and with Pizza.bpmn opened in the editor, click
the "Replay all" button:

Select pizza_ok and pizza_ko by clicking on them while holding "Ctrl". With both
traces selected click the "Resume" button:

PragmaDev Process V2.0 Page 41



Tutorial

The traces will be executed in the background, and the result of such execution will be
shown in the "Status" column:

Note thatmodel coverage canbe generated via the "Generate coverage formarked traces"
button.
Double­clicking a failed trace will:

• Open the trace in the MSC editor and select the concerned element:
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• Select the corresponding element (if possible) in the BPMN editor:
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4 Exploration

Exploration of BPMNmodels in PragmaDevProcess is done viaOBP (seeUserManual).
PragmaDev Process exploration feature can be used to check:

• Complexity: through full exploration of the model.
• Reachability: identification of unreachable paths.
• Deadlock: identification of blocking scenarios.
• Property: verification of a property expressed in either PSC (Property Sequence
Chart) or GPSL (Generic Property Specification Language).

4.1 Complexity check

The tool can automatically execute any possible combination of flows to evaluate the
complexity and the reachability of the model. With Pizza.bpmn opened in the editor
(double­click on it in the project manager), click the "Explore with OBP" button:

Select "Basic exploration", set "Call­activity definition" to "do not consider", and click
the "OK" button:
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The "do not consider" option will step­over call­activities during exploration.
Observe the increasing number of configurations1 while waiting for the exploration to
complete. The number of configuration can be compared to the model complexity to
find out if that result is too high or normal (see User Manual).

4.2 Reachability

An automatic exploration will find any reachable paths in the process. If some symbols
are not reachable there is probably a problem in the model. To identify unreachable
symbols, after an exploration is completed, click the "Show uncovered elements" but­
ton:

Coverage information will be shown as follows:

1The explorationmay be interrupted before completion when using the free version of PragmaDev Pro­
cess.
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All non covered elements during exploration will be marked in red in the editor:

In our example, stepping over the Deliver the pizza call­activity resulted in being
stuck during exploration. This is because the behavior of a stepped over activity is to
wait for all incoming message flows before executing all outgoing message flows. Out­
going sequence flows can be executed only when all message flows have been treated.
The Deliver the pizza call­activity cannot send the pizzamessage before receiving
the moneymessage, which cannot happen.
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"Quit" OBP.

Close also the coverage information window.

4.3 Deadlock check

Now let’s check themodel for deadlocks. A deadlock is a statewhere there are no actions
to performbut the process is not finished (terminated). RunOBPagainwith "Deadlock"
selected:

Observe the result returned by OBP saying that the property was satisfied:

PragmaDev Process V2.0 Page 48



Tutorial

This means that there are no deadlocks in the model.
Note that the presence of non covered elements in the model does not mean that there
is also a deadlock. An infinite loop is a typical case where the process never terminates,
but there is always at least one action to perform. The following section will illustrate
this case using a property.

4.4 Property verification

We will first create a property and then verify it on the model. In the Project Manager
create and add a new PSC file to the project via the button in the toolbar, and name it
property_always_get_pizza:
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Double click on it to open the MSC/PSC Editor, and draw the following property:

The PSC property says the following:
• If the Customer has sent a pizza order to the Clerk, then
• the Delivery Boymust hand over the pizza to the Customer.

To verify this property, with the Pizza.bpmn opened in the editor, click the "Run OBP"
button. Select property_always_get_pizza and click "OK":
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Observe the result returned by OBP saying that the property was violated.2 Property
violation will activate the "Display counter example" button, click it:

When asked to save the MSC, name it pizza_not_delivered and save it. The counter
example will be added to the project:

and displayed in the MSC Editor:

2The exploration will be interrupted before completion when using the free version of PragmaDev Pro­
cess.
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Quit OBP and hit the "Replay" button in the BPMN Editor:
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Select pizza_not_delivered and hit "OK":

Hit the "Run" button in the MSC Editor:

Observe the counter example being replayed in the BPMN editor until the end:
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The property was violated because there exists a case (as shown above) where the Cus-
tomer is stuck in an infinite loop always asking for his/her pizza, and thus never receiv­
ing it.
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5 Simulation

The objective of a simulation is to evaluate the time needed to perform a given process,
as well as its cost. As an example, simulation can help in chosing the best method of
delivery for the pizza, e.g., bike vs car.

5.1 Simulation parameters

5.1.1 Bike delivery

5.1.1.1 Scenario parameters

With the Pizza.bpmn opened in the BPMN editor, select "Simulation scenarios..." in
the "Simulation" menu:

Add a new simulation scenario via the "New / copy scenario" button:
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Name it bike_delivery and hit "Create":

Fill out the scenario attributes as follows and hit "OK":
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The number of replications (i.e. runs) is set to 100, the time will be measured in min­
utes, and cost will be measured in EUR.

5.1.1.2 Element parameters

Time, cost, and control parameters
Simulation properties for every BPMN element in the model can be accessed via the
contextual menu by selecting "Simulation properties...":

Notice that the current scenario is the bike_deliverywe created earlier. Start by con­
figuring the parameters of the Hungry start event. Select "Control parameters: trigger"
and fill the parameters as follows:
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The values mean that every simulation run (i.e. replication) will handle 10 pizza or­
ders with a delay of 10 minutes from one order to the other. Let’s continue with the
simulation parameters for the task Order a pizza:
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This task is set to take from 1 to 5 minutes with a mean of 3 minutes (following a trian­
gular distribution). Next, set the timer to fire after 30 minutes:
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Set the parameters for all the tasks in the main diagramwith the following values (using
a triangular distribution):

Task mode min max
Ask for pizza 3 2 5
Pay the pizza 1 1 2
Get receipt 1 1 2
Eat the pizza 20 15 30
Calm customer 2 1 5
Make the pizza 10 8 15

Switch to the delivery diagram and set the values of the task Get to customer as
follows:
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Note that for this task the "Unit cost" is set to 0.01 EUR/minute. This value represents
a rough estimation of the cost of using a bike for the delivery. Complete the remaining
tasks of the delivery diagram with the following values:

Task mode min max
Get the money 1 1 2
Give the receipt 1 1 2

Result requests
In the element parameters, in addition to simulation inputs (e.g., time, cost, control),
we can set also the desired outputs (or results) of the simulation. The outputs can be
requested on a single BPMN element and/or on a BPMN process. Let’s request some
results from the simulation. Return to the main diagram and go to the simulation prop­
erties of the task Calm customer. Select "count" for the "Results" as shown:
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This will request the number of times the Clerk had to deal with complaints from
Clients. The value will give us an indicator for the service quality, i.e., less complaints
means less unsatisfied clients, which is better for the business.
Still with the properties of Calm customer shown, hit the "Parent process params"
button:
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Select "min", "max", "mean" for both "Elapsed time" and "Unit cost", and hit "OK":
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This will request from the possible simulation results the minimum, average, and max­
imum time and cost needed to perform the Vendor process.

5.1.2 Car delivery

5.1.2.1 Scenario parameters

With the Pizza.bpmn opened in the BPMN editor, select "Simulation scenarios..." in
the "Simulation" menu. Add a new simulation scenario, name it car_delivery, and
make sure its initial values are copied from the bike_delivery scenario:

Hit "Create" to add the new scenario, and then "OK" to apply the changes in the scenar­
ios:

Make sure the current simulation scenario is the new one. For this, in the "Simulation"
menu, select "Change current simulation scenario...":
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Select car_delivery in the list of scenarios and hit "OK":

5.1.2.2 Element parameters

In the delivery diagram, change the simulation properties of the task Get to cus-
tomer as follows:
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Note that the delivery by car takes less time but is more expensive compared to the
delivery by bike.
"Save model" to apply all changes.

5.2 Running the simulation

With the Pizza.bpmn opened in the BPMN editor, and the main diagram shown, hit the
"Simulate" button:
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With both scenarios selected hit the "Run simulation with selected scenario" button:

When done make sure the "Save results" is checked and hit the "Save results & close
dialog" button:

A new simulation results file (in BPSim format) will be added into the project under the
BPMN file:
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Save the project.
Note that simulation results files are not editable. They are always associated to aBPMN
file in the project, and opening a results file will open the corresponding BPMN file in
the editor and load the results with it.

5.3 Simulation results

Double­click the simulation results file to load it in the BPMN editor. Right­click the
task Calm customer and select "Simulation results..." in the contextual menu. Make
sure "Show values" is checked to display the exact values1 in the graph:

1Note that the exact values may differ from the figure.
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The bar graph will show the number of times the task has been executed for each sce­
nario. Compared to the delivery by bike, the number of complaints is significantly lower
when a car is used.
Still with the results of the task Calm customer shown, hit the "Parent process results"
button:
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Select "Cost: unit" in the "Parameter":
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The graph will show the cost for both scenarios, i.e., bike and car delivery. Observe the
cost of bike delivery being significantly lower compared to the delivery by car.
Change the selection in the "Parameter" to "Time: elapsed":
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The graph will show the times of delivery for both scenarios.
A summary of simulation results can be exported in CSV format. For that, in the "Sim­
ulation" menu select "Export simulation results summary...":

The summary is presented as follows:
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5.4 Simulation log

With the simulation results shown, go to the "Log" tab. Select one the entries and hit
the "Save as MSC..." button:
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Name it log.rdd and save it. The trace will be added to the project:

and opened in the MSC editor:
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6 Conclusion

During this tutorial we have been through:
• BPMN,
• Project Manager,
• BPMN Editor,
• BPMN semantic check,
• BPMN Executor,

– Interactive,
– Automatic,

• BPMN Explorer,
– Complexity,
– Reachability,
– Deadlock,
– Property,

• BPMN Simulator,
– Time & cost,
– Scenarios,
– Log,
– Optimization & trade­off.

PragmaDev Process is a powerful tool that allows creation, editing, checking, executing,
exploring, and simulating BMPN models.
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